The Skrooge Handbook
# Contents

1 Introduction ......................................................... 9  
  1.1 Skrooge ......................................................... 9  
  1.1.1 What Skrooge Is ............................................. 9  
  1.1.2 What Skrooge Is Not ........................................ 10  
  1.2 Terminology .................................................... 10  
  1.2.1 Document .................................................... 10  
  1.2.2 Account ..................................................... 10  
  1.2.3 Operation .................................................... 10  
    1.2.3.1 Standard Operation ................................... 10  
    1.2.3.2 Split Operation ........................................ 10  
    1.2.3.3 Transfer ................................................ 10  
    1.2.3.4 Validated Operation ................................... 11  
    1.2.3.5 Pointed Operation ..................................... 11  
    1.2.3.6 Checked Operation .................................... 11  
  1.2.4 Category .................................................... 11  
  1.2.5 Unit ......................................................... 11  

2 Main concepts ....................................................... 12  
  2.1 User Interface ................................................ 12  
    2.1.1 The main area ............................................. 12  
    2.1.2 Docks ..................................................... 12  
    2.1.3 Page Chooser ............................................... 13  
    2.1.4 Bookmarks ................................................ 13  
    2.1.5 Undo / Redo ............................................... 14  
    2.1.6 Property Editor .......................................... 15  
    2.1.7 Message list .............................................. 16  
    2.1.8 Multiple Tabs ............................................. 16  
    2.1.9 Edition Panels ........................................... 16  
    2.1.10 Tables ................................................... 17  
      2.1.10.1 Filter the table .................................... 18  
      2.1.10.2 Search as you type ................................ 18  
    2.1.11 Save Customized Content .............................. 19
The Skrooge Handbook

2.1.11.1 Save page state ........................................... 19
2.1.12 Mass Update .................................................. 20
2.1.13 Status Bar ..................................................... 22
2.2 Import Files ...................................................... 22
  2.2.1 Supported File Formats .................................... 22
  2.2.2 CSV Specificities ........................................... 23
  2.2.3 Importing Operations ..................................... 23
    2.2.3.1 Account .................................................. 23
    2.2.3.2 Unit .................................................... 24
    2.2.3.3 Date .................................................... 24
    2.2.3.4 Import Status ......................................... 24
  2.2.4 Merge operations after import ............................ 24
2.3 Export .......................................................... 24
  2.3.1 Export all your data in one file .......................... 24
  2.3.2 Export partially your data in one file .................... 25
  2.3.3 Export a specific table ................................... 25
  2.3.4 Export Graph .............................................. 25
3 Using Skrooge (beginner) ......................................... 26
  3.1 The main menu ................................................ 26
    3.1.1 The File Menu ............................................ 26
    3.1.2 The Edit Menu ............................................ 27
    3.1.3 The View Menu ........................................... 28
    3.1.4 The Go Menu ............................................. 29
    3.1.5 The Tools Menu .......................................... 32
    3.1.6 The Settings Menu ....................................... 33
  3.2 Dashboard ...................................................... 33
    3.2.1 Advice ..................................................... 34
    3.2.2 Tip of the day ............................................ 34
    3.2.3 Accounts (Light) ........................................ 35
    3.2.4 Accounts (Full) .......................................... 35
    3.2.5 Banks (Light) ............................................. 35
    3.2.6 Banks (Full) ............................................. 35
    3.2.7 Income & Expenditure .................................. 36
    3.2.8 Highlighted operations .................................. 36
    3.2.9 Scheduled operations .................................... 36
    3.2.10 5 main categories of expenditure ...................... 37
    3.2.11 5 main variations ....................................... 37
    3.2.12 Budget .................................................... 37
    3.2.13 Alarms ..................................................... 37
    3.2.14 Report ..................................................... 38
List of Tables

4.1 Scheduled Operations (step 1) .................................................. 62
4.2 Scheduled Operations (step 2) .................................................. 62
4.3 Scheduled Operations (step 3) .................................................. 62
4.4 Scheduled Templates (step 1) .................................................... 63
4.5 Scheduled Templates (step 2) .................................................... 63
4.6 Scheduled Templates (step 3) .................................................... 63

A.1 Search Definition ................................................................. 81
A.2 Update Definition ................................................................. 81
Abstract

This document is a handbook for using Skrooge, a personal finances manager application.
Chapter 1

Introduction

1.1 Skrooge

Skrooge is an application for managing your personal finances. It can keep track of your incomes and expenses across several accounts, in several currencies. It has all the features you should expect from such a tool, such as categories, scheduled operations, graphical reporting, stocks management... It also has some less common features, like fast operation edition, search as you type, refund trackers, customizable attributes...

1.1.1 What Skrooge Is

Skrooge is an Open Source personal finances manager built on KDE frameworks. It is intended to be used by individuals who want to keep track of their incomes, expenses and investments.
1.1.2 What Skrooge Is Not

Skrooge is not a professional tool. It doesn’t have functions expected from a software you would use to run a small business. It doesn’t manage taxes, doesn’t use double-entry system, or any advanced financial function.
If you were looking for such a tool, you may want to look at Kmymoney or Kraft instead.

1.2 Terminology

1.2.1 Document

A document is a Skrooge file (extension .skg). It can contain an indefinite number of accounts. You can use one document to manage all your accounts at once.

1.2.2 Account

A Skrooge account is similar to your bank account. For example, if you own one account for you, one for your wife, and one in common, you can create these three accounts in Skrooge. Every time you spend or earn some money, you register an operation, and indicate the account this operation was made on.

1.2.3 Operation

An operation is either a credit or debit to one of your accounts. If you assign a category or tracker to operations, you can analyze how you spend your money.

1.2.3.1 Standard Operation

A standard operation is the basic operation in Skrooge. For example, “Today, spent 20€ in credit card for groceries”.

1.2.3.2 Split Operation

A split operation is an operation for which the total amount is split over several categories, dates and/or trackers. For example, “Yesterday, spent 100€ at the supermarket, of which 60€ were for food, and 40€ for clothes”.

1.2.3.3 Transfer

A transfer in Skrooge records moving a quantity of money from one of your Skrooge accounts to another.
This must not be confused with the payment mode chosen: if you made a transfer, for example using your bank’s website, to someone else’s account, this is not a transfer operation, because Skrooge doesn’t know about that other person’s account. It is a standard operation with transfer as its payment mode.
Read the transfer section if things are still unclear.
1.2.3.4 Validated Operation

When you import operations from your financial institution into Skrooge, they are not considered valid right away and appear in blue. You need to manually validate them. Such validated operations no longer appear blue.

Note that it is possible to automatically validate operations on import, by turning on the corresponding option in the settings.

1.2.3.5 Pointed Operation

During the reconciliation process, you point in Skrooge all operations that appear in the corresponding account position. Such pointed operations display a half-filled square in the Status column of an operations view. A pointed operation is not Checked until you complete reconciliation.

1.2.3.6 Checked Operation

When all operations on your account’s position have been pointed in Skrooge, you can complete the reconciliation process. Skrooge then turns all Pointed operations into Checked Operations, which display a filled square in the Status column of an operations view.

1.2.4 Category

A category is basically a class of operations. Some classic examples include “Food”, “Taxes”, “Salary”... A category can contain other categories: it is a hierarchical structure. For example, category “transport” can contain categories “Bus”, “Automotive”, “plane”... Skrooge handles an infinite depth of categories.

1.2.5 Unit

A unit in Skrooge can be anything that has a value. Examples:

- Currency
  - $ (US Dollar)
  - € (euro)
  - £ (Sterling Pound)
- Stock or index
  - GOOG (Google)
  - NASDAQ
- Anything you own
  - Your house
  - Your car
Chapter 2

Main concepts

2.1 User Interface

The Skrooge window is composed of a main area, surrounded by docks, and a status bar. Docks can be closed and reopened, and positioned left or right of the main area.

2.1.1 The main area

This is where Skrooge will display the information you are interested in. It can contain many tabs, each one with the view you assigned to it.

2.1.2 Docks

Docks can be found in many KDE applications. They are a subpart of an application window, and can be relocated, stacked, closed, or even detached from the main window.

Some examples of docks layout:

Skrooge docks are:
The page chooser

The bookmark list

The undo / redo browser

The property editor

The messages list

### 2.1.3 Page Chooser

The page chooser is a dock where you can select the view to be displayed in the current tab or in a new tab. To open in a new tab, hold the Ctrl key while clicking on the selected view.

**Tip**

You can customize this list by using the contextual menu on this list.

Each context will be described in a specific chapter in this handbook.

### 2.1.4 Bookmarks

Imagine you need to customize the operations view on a per account basis: each account would be displayed in its own tab, maybe with different columns in each table. The forementioned method does not work, since it applies on all tabs with the same type.

The solution here is to save each individual tab as a Bookmark. Much like in a web browser, bookmarks can be organized in a hierarchy of bookmark folders, that you can visualize in the Bookmark Browser:
To create a bookmark, select a page from the page chooser you want to bookmark, and customize its content to your liking. Once you are done with that, in the Bookmarks dock, bring up the contextual menu, and select **Bookmark current page**.

Each bookmark or bookmark folder can be “autostarted”, i.e. it will be automatically opened when starting Skrooge. This way, you can fully customize the default Skrooge layout.

You can select the text and icon you want for each bookmark or bookmark folder.

### 2.1.5 Undo / Redo

Skrooge manages undo/redo in a rather classic fashion, except that you can undo or redo any action, even if it was made several days ago. As per default settings, the history is not cleared upon closing Skrooge (you can change this behaviour in the **settings**), which means you could undo virtually everything up to the document creation.

In order to limit the impact on filesize, Skrooge is configured by default to keep a history of 50 entries. You can change this value in the **settings**.

Skrooge has a dock that lists all undoable actions.

The history browser shows three columns:

- an icon showing the state of the action. A yellow counter clockwise arrow means the action is undoable. A green clockwise icon means the action is redoable.
- the description of the action
The Skrooge Handbook

- the date when the action was made
- a disk icon ![disk icon](image) means this action corresponds to a saved state, i.e. the document was saved right after this action.

To undo an undoable operation, or redo a redoable operation, double click on it.

### 2.1.6 Property Editor

One of Skrooge rather uncommon features is the ability to add custom properties to any object. For example, you may want to add the name and phone number of a bank employee to an account, because he / she is your contact. Or maybe attach a file to an operation, like an invoice scan.

This can be achieved using the property editor, which is a dock of its own.

When this dock is visible, it will display the custom properties of the selected object (For: Selection) or of all objects (For: All), whether it is an account, an operation, category, unit... This dock allows to create, update or delete properties.

A property can be:

- A simple string
- A copied file whatever the format (odt, png, pdf, ...). It means that the file is copied into the Skrooge document. This file can be opened from Skrooge by clicking on the appropriate button. Take care, all modifications of original file are not replicated in the version saved in Skrooge document.
- A link to an existing file whatever the format (odt, png, pdf, ...). It means that the file is not copied into the Skrooge document but just linked. This file can be opened from Skrooge by clicking on the appropriate button.
- A link to an http page. Example: the website of your bank.

Added properties can be displayed as a column on tables.
2.1.7 Message list

This dock allows you to see all messages displayed.

![Message list dock](image)

Each context will be described in a specific chapter in this handbook.

2.1.8 Multiple Tabs

Skrooge can display several tabs. You can add as many tabs as you want, each one containing the information you need. The above screenshot shows 4 tabs (accounts, operations, and two graphs).

![Multiple tabs](image)

2.1.9 Edition Panels

In most Skrooge tabs, the way to edit items is to use the edition panel, located at the bottom of the page. In order to preserve maximum space for visualizing information, especially on small screens, edition panels can be hidden or displayed using buttons.

![Edition panel](image)
When more than one edition mode is available, several buttons allow choosing amongst them. In the above screenshot, there are four buttons allowing to choose the edition mode for Operations, “Standard”, “Split”, “Transfer” and “Shares”.

All numerical fields are interpreted. It means that you can enter mathematical expressions like this:

- 5*3+10
- 5*(3+10)
- Math.sin(10)

### 2.1.10 Tables

In Skrooge, all tables are customizable. Bring up the contextual menu (usually by right-clicking) on the column header, and you will see a menu appear:

![Contextual Menu Example]

**Columns**
Customize the columns appearance.

**View Appearance**
Use a predefined set of columns. The “default” column usually shows all columns. Other predefined sets may exist on a per table basis.

**Resize to Content**
Resize all columns to fit to the content.

**Auto Resize**
When activated, you will not be able to manually resize columns, Skrooge will do it automatically based on the columns content.

**List of displayed columns**
Shows the list of all columns that can be displayed for this table. The ones currently displayed are ticked. Untick to hide a column, tick to show. The added properties can be selected to be displayed as a column.
Group by

Choose how to group the lines.

None
No grouping.

Sorting column
The lines will be grouped by the column where the sort is applied.

List of columns
Shows the list of all columns that can be used for grouping.

Alternate row colors
Alternate the colors used for each row. The colors used are based on the chosen KDE color scheme.

Export

Export the table as a stand-alone file. Supported formats are pdf, csv, html, SVG, odt or txt.

You may also click on a header to choose the sorting column, or reorder columns by dragging them left or right.

2.1.10.1 Filter the table

In all Skrooge views, you will find a “Show” drop down menu allowing you to limit what the table displays.

2.1.10.2 Search as you type

In all Skrooge views, you will find a search field that filters the table to only display lines matching what you type:

- In an operations view, it will filter the operations containing the text entered, whatever the column (date, payee, category, comment...)
- In an accounts view, it will filter the accounts containing the text entered, whatever the column (bank, account name, number...)
- In a report view, it will redraw the graph based on this filter
- In a... well, you get the idea, right?
The filtering string follows these rules:

- Searching is case-insensitive. So table, Table and TABLE are all the same.
- If you enter a word or series of words in the search box, the application will filter the table to only display lines having these words (logical operator AND).
- If you want to add (logical operator OR) some lines, you must prefix your word by “+”.
- If you want to remove (logical operator NOT) some lines, you must prefix your word by “-”.
- If you want to search only on one column, you must prefix your word by the column name, like: col1:word.
- If you want to use the character “:” in value, you must specify the column name, like: col1:value:rest.
- If you want to search for a phrase or something that contains spaces, you must put it in quotes, like: “yes, this is a phrase”.
- You can also use operator “<” and “>”.

Some examples may help explain:

- `+val1 +val2` => Keep lines containing val1 OR val2
- `+val1 -val2` => Keep lines containing val1 but NOT val2
- ``abc def`` => Keep lines containing the sentence “abc def”
- ``-att:abc def`` => Remove lines having a column name starting by att and containing “abc def”
- `abc:def` => Keep lines having a column name starting by abc and containing def
- `:abc:def` => Keep lines containing “abc:def”
- `Date>2015-03-01` => Keep lines where Date attribute is greater than 2015-03-01
- `Amount<10` => Keep lines where Amount attribute is less than 10

### 2.1.11 Save Customized Content

As explained in the previous chapter, tables can be totally customized to your liking. But you probably do not want to loose all the customization work you made upon closing a tab. There are two ways to save this work.

#### 2.1.11.1 Save page state

This option allows you saving the current tab state as the default state that will always be called when opening this page. For example, you may want your Dashboard to contain 4 widgets, organized to your liking. What’s even more important is that you always want the Dashboard to look the same, you do not want to repeat the customization work every time you open it.

To do this, you simply need to do customization work once, then to save the tab state as the Default State for the page being displayed. Setting the default state is done either by right clicking on the tab and selecting **Save page state**. If you want to keep more than one state for a page then you must use bookmarks.
A faster way is to click on the disk icon that appears on the left of the tab title whenever you modified the default state in a tab.

### 2.1.12 Mass Update

In Skrooge, it is possible to massively update a selection of items. Though mostly useful for operations, it can also be used on accounts, units, scheduled operations...

The way to do this is quite straightforward: select items to be updated, set the attribute value(s) that should be applied on all items, and click on **Apply**. For all attributes where you didn’t set a value, it will be left untouched on items.
Set mode as “Credit Card” and payee as “ACME” on selected operations.

Updated operations.

NOTE
It is intentionally impossible to set date or quantity with a mass update.
2.1.13 Status Bar

The status bar is a small section at the bottom of the Skrooge window, displaying various information as you work. It includes a progress bar and a cancel button, in case you want to interrupt a long task, such as importing a large file.

2.2 Import Files

Skrooge is able to import files from other financial applications or from your bank. So, whether you are coming from another application, or simply do not want to go through the hassle of manually entering your operations, Skrooge has a fast lane for you.

2.2.1 Supported File Formats

One the following formats may be used:

- AFB120: A French norm.
- CSV: Comma Separated Value. Though not strictly a financial format, it is quite often available as an export format from banks or other applications, mostly because it is so easy to use in a spreadsheet.
- GnuCash: Format of the GnuCash application. If you want to migrate from this application, this is the recommended format to use.
- Grisbi: Format of the Grisbi application. If you want to migrate from this application, this is the recommended format to use.
- Homebank: Format of the Homebank application. If you want to migrate from this application, this is the recommended format to use.
- Kymoney: Format of the Kymoney application. If you want to migrate from this application, this is the recommended format to use.
- MT940: An international norm defined by SWIFT.
- Microsoft® Money: Format of the Microsoft® Money application. If you want to migrate from this application, this is the recommended format to use.
- Money Manager Ex: Format of the Money Manager Ex application. If you want to migrate from this application, this is the recommended format to use.
- OFX: Open Financial eXchange. It is a well defined & documented format, that Skrooge imports using a third party library (libofx). This is the recommended format for imports.
- QFX: QFX is a customization of OFX from the commercial software Quicken™.
- QIF: Quicken™ Import File. Maybe the most common financial file format. However, it has some rather annoying limitations, like not giving the unit for operation, or no strict date formatting.
- IIF: Intuit™ Interchange Format is used by QuickBooks™.
- SKG: This is useful to merge 2 Skrooge documents
The Skrooge Handbook

- **PDF:** This allows to create the operation from a PDF invoice. The invoice is also associated to the operation as a property. Read the How to if you want to know how to extract information from an invoice not supported yet.

- **Backend:** Skrooge can also import operations by using a backend. For the moment, the three following backends can be used:
  - **weboob:** By using this backend you can import all operations from all your banks in only one click. For that, you just have to install weboob and activate the corresponding backend from settings.
  - **weboob_coming:** By using this backend you can import all coming operations from all your banks in only one click. This can be used for card with deferred debit. For that, you just have to install weboob and activate the corresponding backend from settings.
  - **aqbanking:** By using this backend you can import all operations from all your banks in only one click. For that, you just have to install and configure aqbanking-cli.

**Tip**

If you do not want to store your bank passwords in the configuration file of WEBOOB, you can do that:

- Add passwords for each bank by doing `kwallet-query -f Weboob kdewallet -w m_bank_name`
- Edit the file `~/.config/weboob/backends` in your favorite text editor
- Replace in the config file `password = my_password` by `password = "kwallet-query -f Weboob kdewallet -r m_bank_name"`

### 2.2.2 CSV Specificities

Since CSV has no strictly defined format, there is no way for Skrooge to know where it is supposed to find dates, categories, values... To do so, Skrooge expects your CSV file to contain some headers indicating what is the column for. The file must contain at least columns “Date” and “Amount”.

You may manually define how the file is set up (i.e. ignoring the headers in the file) by setting them in the application’s settings (Settings → Configure Skrooge), in the Import / Export section.

### 2.2.3 Importing Operations

One of Skrooge principles is to avoid multiple wizards or dialog boxes. This is especially true for imports, where other applications require many information from the user. Not Skrooge. When selecting **File → Import**, you will be asked to select the files (yes you can import many at once), and that’s it. Behind the scene, Skrooge will find the file format and apply the relevant import mode.

#### 2.2.3.1 Account

One thing that might surprise you is that you won’t be asked in which account the operations should be imported. That is because Skrooge will read the account number in the file, and will associate imported operations to that account.

If no account exists with this account number, or if the file does not contain this information, Skrooge will use the file name as the account number.

If there is still no account with that number, Skrooge will create a new account having the filename as the account number, and import all operations in that account. You will then be free to either rename the account, perform a **mass update**, or use **Search & Process** to associate imported operations to an existing account.
2.2.3.2 Unit

If no unit is specified in the imported file (which is often the case for QIF & CSV), Skrooge will assume the unit is your primary currency. If this was not the case, use the Search & Process function to correct.

2.2.3.3 Date

Sometimes, the input files will not have dates formatted as per your country’s customs (it may happen in QIF or CSV, OFX has an imposed date format). Skrooge will do its best to detect the format. If this doesn’t work as expected, you can force the date format in the application’s settings.

2.2.3.4 Import Status

Imported Operations have a specific status. Right after import, they are considered as “Imported, not yet validated”. The idea here is that you may want to check if the import went as expected, so you need to identify quickly those operations. As per default settings, those operations will also appear in blue.

**Tip**
If you do not want this behaviour, you can set the option Automatic Validation after Import in the application’s settings.

**Tip**
The Search & Process function can be automatically launched after import to categorize operations.

2.2.4 Merge operations after import

There are some cases where you have manually entered an operation, but also imported it from your bank. In such cases, the operation will appear twice in the list.

You may merge these two operations by selecting them, and select Merge imported operations in the contextual menu or the edit menu. This will add all information you manually entered to the imported operation, and will delete the manually entered operation.

2.3 Export

There are different ways of exporting data with Skrooge depending on what you intend to do.

2.3.1 Export all your data in one file

Using the menu File → Export, a CSV, QIF, JSON, Kmymoney, Ledger, IIF, Sqlite, Sqlcipher or XML file will be created, containing all operations in the current document. This is the option to choose if you need to export your data to another application.
2.3.2  Export partially your data in one file

If you select some accounts or some operations before using the menu File → Export, a CSV, QIF, JSON, Kymoney, Ledger, IIF, Sqlite, Sqlcipher or XML file will be created, containing the selected accounts (with their operations) or the selected operation. This is the option to choose if you need to export your data to another application.

2.3.3  Export a specific table

All tables in Skrooge can be exported, either in CSV, HTML, ODT, PDF, SVG or TXT format.

This works wherever a table is displayed, so you can use it to export whatever tabular information you need.

2.3.4  Export Graph

Skrooge allows you exporting a graph, either in PDF, SVG or just any image format supported by Qt™ (PNG, JPG, GIF, TIFF...). You can do so by right-clicking on the graph, and choosing the Export option.
Chapter 3

Using Skrooge (beginner)

3.1 The main menu

Skrooge follows the standard KDE menu scheme. So it has many menu entries that are common for all KDE applications. More information on these menu entries can be found this help section. Below, you can find descriptions for Skrooge specific menu entries.

3.1.1 The File Menu

You can find in this menu all functions relative to the Skrooge document

- **Change password...**: To change the password. Let the field empty to remove the password
- **Print...**: To print the open pages
- **Print preview**: To display the preview before printing
• **Import**: To import data.

<table>
<thead>
<tr>
<th>Option</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import standard bookmarks</td>
<td>Meta+Ctrl+I</td>
</tr>
<tr>
<td>Import categories</td>
<td></td>
</tr>
<tr>
<td>Import...</td>
<td>Meta+Ctrl+W</td>
</tr>
<tr>
<td>Import with backends</td>
<td></td>
</tr>
<tr>
<td>Import currency values...</td>
<td></td>
</tr>
<tr>
<td>Import rules...</td>
<td></td>
</tr>
</tbody>
</table>

- **Import standard bookmarks**: To import the standard bookmarks. They are created at the creation of a new document.
- **Import categories**: To import a set of predefined categories. This option depends on your country.
- **Import**: To import operation from files
- **Import with backend**: To import operations with all declared backends
- **Import currency values...**: To import currency values from files. Of course, the csv file must have the three columns (unit, date and amount).
- **Import rules...**: To import **Search and process** rules to associate a category to a payee. Of course, the csv file must have the two columns (payee and category).

• **Export...**: To export operations into a file

### 3.1.2 The Edit Menu

You can find in this menu all functions that can be used to modify selected objects

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Shift+Z</td>
</tr>
<tr>
<td>Revert document</td>
<td>Ctrl+Alt+Z</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
<tr>
<td>Add property</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Fast edit</td>
<td>F10</td>
</tr>
<tr>
<td>Find...</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Switch highlight</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Switch close</td>
<td></td>
</tr>
<tr>
<td>Reconcile...</td>
<td>Alt+R</td>
</tr>
<tr>
<td>Point</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Group operations</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Ungroup operations</td>
<td>Ctrl+Shift+G</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Create template</td>
<td>Ctrl+Shift+T</td>
</tr>
<tr>
<td>Apply template</td>
<td></td>
</tr>
<tr>
<td>Merge sub operations</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Schedule</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Validate imported operations</td>
<td>Ctrl+Shift+V</td>
</tr>
<tr>
<td>Merge imported operations</td>
<td>Ctrl+Alt+M</td>
</tr>
<tr>
<td>Split share...</td>
<td>Alt+Y</td>
</tr>
</tbody>
</table>

• **Undo**: Cancel the previous modification done
The Skrooge Handbook

- **Redo**: Reapply the previous modification canceled
- **Revert document**: Cancel the previous modifications done up to the last save
- **Delete**: Delete the selected objects (operations, accounts, categories, ...)
- **Add property**: Add a property regularly used on the selected objects
- **Select all**: Select all lines of the table of the current page
- **Fast edit**: Facilitation the creation of new operations by filling fields automatically based on previous operations created
- **Find...**: Open the Search and process page with a predefined filter corresponding to the selected objects
- **Switch highlight**: Switch the highlight state of objects
- **Switch close**: Switch the close state of objects
- **Reconcile...**: Open the Operations page in reconciliation mode
- **Point**: Point the selected operations
- **Group operations**: Group the selected operations. It serves to keep a link between operations. It is used in the case of transfers between accounts or in the case of buying/selling shares. You can use it for any other purpose. Be aware that reports and graphs allow you to ignore or to take into account the grouped operations
- **Ungroup operations**: Ungroup the selected operations
- **Duplicate**: Duplicate the selected operation to create a new one from a previous one
- **Create template**: Create a template from a selected operation
- **Apply template**: Apply a template on selected operations
- **Merge sub operations**: Merge selected operations in one split operation
- **Schedule**: Schedule the selected operation
- **Switch validation of imported operations**: Validate all selected imported operations
- **Merge imported operations**: Merge one imported operation with another operation entered manually. If amounts are different then a confirmation is requested
- **Split share**: Split selected share

### 3.1.3 The View Menu

You can find in this menu all functions relative to pages
The Skrooge Handbook

<table>
<thead>
<tr>
<th>Enable editor</th>
<th>Ctrl+Ins</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Tab</td>
<td>Ctrl+Maj+W</td>
</tr>
<tr>
<td>Reopen last page closed</td>
<td>Ctrl+Alt+T</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Close All</td>
<td>Alt+W</td>
</tr>
<tr>
<td>Close All Other</td>
<td>Ctrl+Alt+W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pin this page</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset page state</td>
<td>Ctrl+Alt+R</td>
</tr>
<tr>
<td>Save page state</td>
<td>Ctrl+Alt+S</td>
</tr>
<tr>
<td>Overwrite bookmark state</td>
<td>Ctrl+Alt+B</td>
</tr>
</tbody>
</table>

- **Enable editor**: Activate the editor on the current page
- **New tab**: Open a new tab
- **Reopen last closed page**: Recover the last closed page
- **Close**: Close the current page
- **Close All**: Close all pages except pinned ones
- **Close All Other**: Close all pages except the current one and the pinned ones
- **Pin this page**: Set the current page pinned. This will avoid replacement by another one or closure
- **Reset page state**: Reset the status of the current page
- **Save page state**: Save the status of the current page
- **Overwrite bookmark state**: Save the status of the current bookmarked page. The bookmark is updated with the new state

### 3.1.4 The Go Menu

You can find in this menu all functions relative to pages
- **Home**: Close all pages and reopen all bookmarks autostarted like when the document is opened
- **Previous**: Change the content of the current page with the content of the previous one. Like in a web browser
- **Next**: Change the content of the current page with the content of the next one. Like in a web browser
- **Open highlights...**: Open highlighted operations
- **Open last modified...**: Open operations modified by the last action done
- **Open potential duplicates...**: Open operations opens a page with operations having same amounts and same dates
- **Open sub operations...**: Open sub operations of the selected operation. Similar to a double click
- **Open report...**: Open a report based on the selection. This is really useful. For example: if you select 2 accounts and launch this action then the report page will be opened but only for operations of those accounts
- **Open imported operations not yet validated...**: nothing to add
- **Open operations without category...:** Open all operations not having a category
- **Open transfers without category...:** Open all transfers not having a category
- **Open operations without payee...:** Open all operations not having a payee
- **Open transfers without payee...:** Open all transfers not having a payee
- **Open operations without mode...:** Open all operations not having a mode
- **Open operations with dates not aligned...:** Open all single operations not having the date aligned with its sub operation
- **Open operations with comments not aligned...:** Open all single operations not having the comment aligned with its sub operation
- **Open operations in groups with only one operation...:** Open all single operations alone in a group
- **Open very old operations:** nothing to add
### The Tools Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find and group transfers</td>
<td>Create potential transfers</td>
</tr>
<tr>
<td>Clean bank’s imports</td>
<td>Clean operations after imports</td>
</tr>
<tr>
<td>Anonymize</td>
<td>Anonymize your document to help debugging of Skrooge</td>
</tr>
<tr>
<td>Align comment of suboperations of selected operations</td>
<td>Correct single operations having comments not aligned</td>
</tr>
<tr>
<td>Align date of suboperations of selected operations</td>
<td>Correct single operations having dates not aligned</td>
</tr>
<tr>
<td>Remove groups with only one operation of selected operations</td>
<td>Correct alone in a group</td>
</tr>
<tr>
<td>Delete unused payees</td>
<td>nothing to add</td>
</tr>
<tr>
<td>Delete unused categories</td>
<td>nothing to add</td>
</tr>
<tr>
<td>Delete unused units</td>
<td>nothing to add</td>
</tr>
<tr>
<td>Validate operations that do not require further action</td>
<td>Validate imported operations</td>
</tr>
<tr>
<td>Process budget rules</td>
<td>Recompute the budgets based on defined rules</td>
</tr>
</tbody>
</table>

- **Find and group transfers**: Create potential transfers
- **Clean bank’s import**: Clean operations after imports
- **Anonymize**: Anonymize your document to help debugging of Skrooge
- **Align comment of suboperations**: Correct single operations having comments not aligned
- **Align date of suboperations**: Correct single operations having dates not aligned
- **Remove groups with only one operation**: Correct alone in a group
- **Delete unused payees**: nothing to add
- **Delete unused categories**: nothing to add
- **Delete unused units**: nothing to add
- **Validate operations that do not require further action**: Validate imported operations
- **Process budget rules**: Recompute the budgets based on defined rules
3.1.6 The Settings Menu

- **Show Menubar**: To show or hide the menu
- **Toolbars Shown**: To show or hide the toolbars
- **Show Statusbar**: To show or hide the status bar
- **Configure Keyboard Shortcuts...**: To change the shortcuts of each command
- **Configure Toolbars...**: To modify the toolbars layouts
- **Configure Notifications...**: To modify the notifications
- **Configure Skrooge...**: To access to the main settings of Skrooge

3.2 Dashboard

The Dashboard is a Skrooge plugin that displays global information about your financial situation.

You can add new graphical items using button on the top right corner. You can configure each graphical item by clicking on the icon on it. You can organize the graphical items on the dashboard by using the drag and drop.
3.2.1 Advice

This graphical item displays some advice by order of priority. For each of them, you will be able to:

- Open or clean concerned operations
- Dismiss this advice
- Dismiss this advice for the current month
- Dismiss this kind of advice
- Dismiss this kind of advice for the current month

3.2.2 Tip of the day

Display the tip of the day. You can click on the graphical item to see the next tip.
3.2.3 Accounts (Light)

<table>
<thead>
<tr>
<th>Accounts</th>
<th>31/01/2017</th>
<th>28/02/2017</th>
<th>%</th>
<th>28/02/2016</th>
<th>28/02/2017</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon compte</td>
<td>-8 037,00 €</td>
<td>-8 037,00 €</td>
<td>+5,38 %</td>
<td>-7 421,00 €</td>
<td>-8 037,00 €</td>
<td>-8,30 %</td>
</tr>
<tr>
<td>Total of Current</td>
<td>-8 037,00 €</td>
<td>-8 037,00 €</td>
<td>+5,38 %</td>
<td>-7 421,00 €</td>
<td>-8 037,00 €</td>
<td>-8,30 %</td>
</tr>
<tr>
<td>Livret A</td>
<td>13 000,00 €</td>
<td>13 000,00 €</td>
<td>+0,78 %</td>
<td>11 800,00 €</td>
<td>13 000,00 €</td>
<td>+10,17 %</td>
</tr>
<tr>
<td>PEL</td>
<td>0,00 €</td>
<td>0,00 €</td>
<td>∞</td>
<td>0,00 €</td>
<td>0,00 €</td>
<td>∞</td>
</tr>
<tr>
<td>Total of Investment</td>
<td>13 000,00 €</td>
<td>13 000,00 €</td>
<td>+0,78 %</td>
<td>11 800,00 €</td>
<td>13 000,00 €</td>
<td>+10,17 %</td>
</tr>
<tr>
<td>Total</td>
<td>4 963,00 €</td>
<td>4 963,00 €</td>
<td>+12,64 %</td>
<td>4 379,00 €</td>
<td>4 963,00 €</td>
<td>+13,34 %</td>
</tr>
</tbody>
</table>

Display the balance of each account and type of account. You can configure this graphical item to select what you want to see.

3.2.4 Accounts (Full)

<table>
<thead>
<tr>
<th>Accounts (Full)</th>
<th>31/01/2017</th>
<th>28/02/2017</th>
<th>%</th>
<th>28/02/2016</th>
<th>28/02/2017</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon compte</td>
<td>-8 037,00 €</td>
<td>-8 037,00 €</td>
<td>+5,38 %</td>
<td>-7 421,00 €</td>
<td>-8 037,00 €</td>
<td>-8,30 %</td>
</tr>
<tr>
<td>Total of Current</td>
<td>-8 037,00 €</td>
<td>-8 037,00 €</td>
<td>+5,38 %</td>
<td>-7 421,00 €</td>
<td>-8 037,00 €</td>
<td>-8,30 %</td>
</tr>
<tr>
<td>Livret A</td>
<td>13 000,00 €</td>
<td>13 000,00 €</td>
<td>+0,78 %</td>
<td>11 800,00 €</td>
<td>13 000,00 €</td>
<td>+10,17 %</td>
</tr>
<tr>
<td>PEL</td>
<td>0,00 €</td>
<td>0,00 €</td>
<td>∞</td>
<td>0,00 €</td>
<td>0,00 €</td>
<td>∞</td>
</tr>
<tr>
<td>Total of Investment</td>
<td>13 000,00 €</td>
<td>13 000,00 €</td>
<td>+0,78 %</td>
<td>11 800,00 €</td>
<td>13 000,00 €</td>
<td>+10,17 %</td>
</tr>
<tr>
<td>Total</td>
<td>4 963,00 €</td>
<td>4 963,00 €</td>
<td>+12,64 %</td>
<td>4 379,00 €</td>
<td>4 963,00 €</td>
<td>+13,34 %</td>
</tr>
</tbody>
</table>

Display the balance of each account and type of account. The balance can be compared with the balance one month before and one year before.

3.2.5 Banks (Light)

<table>
<thead>
<tr>
<th>Banks (Light)</th>
<th>28/02/2017</th>
</tr>
</thead>
<tbody>
<tr>
<td>banque postale</td>
<td>13 000,00 €</td>
</tr>
<tr>
<td>caisse epargne</td>
<td>0,00 €</td>
</tr>
<tr>
<td>societe generale</td>
<td>-8 037,00 €</td>
</tr>
<tr>
<td>Total</td>
<td>4 963,00 €</td>
</tr>
</tbody>
</table>

Display the balance of each bank. The corresponding report can be directly opened from the graphical item.

3.2.6 Banks (Full)

<table>
<thead>
<tr>
<th>Banks (Full)</th>
<th>31/01/2017</th>
<th>28/02/2017</th>
<th>%</th>
<th>28/02/2016</th>
<th>28/02/2017</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>banque postale</td>
<td>12 900,00 €</td>
<td>13 000,00 €</td>
<td>+0,78 %</td>
<td>11 800,00 €</td>
<td>13 000,00 €</td>
<td>+10,17 %</td>
</tr>
<tr>
<td>caisse epargne</td>
<td>0,00 €</td>
<td>0,00 €</td>
<td>∞</td>
<td>0,00 €</td>
<td>0,00 €</td>
<td>∞</td>
</tr>
<tr>
<td>societe generale</td>
<td>-8 494,00 €</td>
<td>-8 037,00 €</td>
<td>+5,38 %</td>
<td>-7 421,00 €</td>
<td>-8 037,00 €</td>
<td>-8,30 %</td>
</tr>
<tr>
<td>Total</td>
<td>4 406,00 €</td>
<td>4 963,00 €</td>
<td>+12,64 %</td>
<td>4 379,00 €</td>
<td>4 963,00 €</td>
<td>+13,34 %</td>
</tr>
</tbody>
</table>
Display the balance of each bank. The balance can be compared with the balance one month before and one year before.

### 3.2.7 Income & Expenditure

<table>
<thead>
<tr>
<th>Income &amp; Expenditure</th>
<th>Current month</th>
<th>Previous month</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomes</td>
<td>1 600,00 €</td>
<td>1 600,00 €</td>
</tr>
<tr>
<td>Expenditures</td>
<td>1 043,00 €</td>
<td>2 393,00 €</td>
</tr>
<tr>
<td>Savings</td>
<td>557,00 €</td>
<td>-793,00 €</td>
</tr>
</tbody>
</table>

Display the incomes, expenditures and savings for two different periods (example: current month, current year, previous month, ...). Of course, you can:

- Select the two periods you want
- Choose if transfers are taken into account or not
- Choose if tracked operations are taken into account or not
- Open the corresponding report

### 3.2.8 Highlighted operations

<table>
<thead>
<tr>
<th>Highlighted operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/02/2011 CARBURANT -50.00 €</td>
</tr>
<tr>
<td>22/02/2011 ALIMENTATION -100.00 €</td>
</tr>
<tr>
<td>01/03/2011 IMPOT -158.00 €</td>
</tr>
</tbody>
</table>

Display the list of highlighted operations.

### 3.2.9 Scheduled operations

<table>
<thead>
<tr>
<th>Scheduled operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>14/02/2017 ALIMENTATION -100.00 €</td>
</tr>
<tr>
<td>15/02/2017 ASF -100.00 €</td>
</tr>
<tr>
<td>01/03/2017 SALAIRE 1500.00 €</td>
</tr>
<tr>
<td>01/03/2017 IMPOT -158.00 €</td>
</tr>
<tr>
<td>01/03/2017 LOYER -550.00 €</td>
</tr>
</tbody>
</table>

Display the list of scheduled operations.
3.2.10  5 main categories of expenditure

<table>
<thead>
<tr>
<th>Category</th>
<th>ALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: Frais généraux &gt; Loyer</td>
<td>60 500,00 €</td>
</tr>
<tr>
<td>2: Alimentation &gt; Épicerie</td>
<td>47 600,00 €</td>
</tr>
<tr>
<td>3: Taxes et impôts &gt; Impôts sur le revenu</td>
<td>17 380,00 €</td>
</tr>
<tr>
<td>4: Automobile &gt; Péage</td>
<td>10 900,00 €</td>
</tr>
<tr>
<td>5: Automobile &gt; Carburant</td>
<td>9 300,00 €</td>
</tr>
<tr>
<td>6: Others</td>
<td>26 673,00 €</td>
</tr>
</tbody>
</table>

Display the 5 main categories of expenditure for the desired period.

3.2.11  5 main variations

- Expenses in category 'Alimentation > Épicerie' decreased by +80,00 % for a total of 100,00 €.
- Expenses in category 'Automobile > Carburant' decreased by +50,00 % for a total of 50,00 €.

Display the 5 main variations of income and expenditure for the desired period.

3.2.12  Budget

<table>
<thead>
<tr>
<th>Category</th>
<th>Corrected budget</th>
<th>Amount</th>
<th>Delta after rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alimentation &gt; Épicerie</td>
<td>780,27 €</td>
<td>-1 143,11 €</td>
<td>-1 923,38 €</td>
</tr>
<tr>
<td>Automobile &gt; Carburant</td>
<td>-700,00 €</td>
<td>-217,81 €</td>
<td>482,19 €</td>
</tr>
<tr>
<td>Total</td>
<td>80,27 €</td>
<td>-1 360,92 €</td>
<td>-1 441,19 €</td>
</tr>
</tbody>
</table>

Display the budget for the desired period.

3.2.13  Alarms

Display the alarms defined in Search and Process.
3.2.14 Report

Display the report you want.

3.2.15 Quotes

<table>
<thead>
<tr>
<th>Share</th>
<th>Price</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM (IBM)</td>
<td>116,40 €</td>
<td>(0,00 %)</td>
</tr>
<tr>
<td>Novell (Novell)</td>
<td>143,86 €</td>
<td>(0,00 %)</td>
</tr>
<tr>
<td>Index</td>
<td>CAC 40 (CAC 40)</td>
<td>4 020,21 €</td>
</tr>
</tbody>
</table>

Display the quote of the defined units and the variations. You can choose the types of units to display.

3.2.16 Portfolio

<table>
<thead>
<tr>
<th>Unit</th>
<th>Quantity</th>
<th>Purchase amount</th>
<th>Initial amount</th>
<th>28/02/2017</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIRBUS</td>
<td>12,00</td>
<td>0,00 €</td>
<td>265,02 €</td>
<td>784,80 €</td>
<td>519,78 € (+1,96 %)</td>
</tr>
</tbody>
</table>

Display all information relative to the shares you have.
3.2.17 Estimated interest

Display the estimation of interest for each account. You have to use the simulation page to define the rate of each account.

3.2.18 Personal financial score

Display your personal financial score.

3.3 Bank & Accounts

This is the plugin dedicated to managing your different accounts.

3.3.1 Account properties

A Skrooge account has the following properties:
The Skrooge Handbook

Bank
You may choose a bank from the drop down box (containing the list of known banks for your country), or type the name if your bank is not in the list (If the list is empty, the Skrooge team has not yet been provided this information. You may contact us to help!).

Account
The name you want to use for this account.

Type
The account type can be
- Current
- Credit Card: This kind of account has a specific reconciliation mode.
- Saving
- Investment
- Assets
- Loan: The transfers to this kind of account are not taken into account in reports.
- Pension
- Wallet: This kind of account does not have bank name.
- Other

Bank Number
The identification number of your bank

Agency Number
The identification number of the agency

Account Number
The identification number of the account. This value is very important to match the appropriate account during imports

Address
The address of the agency

Comment
Anything you want!

Initial balance
The initial amount of the account

Minimum limit
The minimum limit when Skrooge must raise an alarm

Maximum limit
The maximum limit when Skrooge must raise an alarm

3.3.2 Accounts list
The accounts list takes the form of a table with one line per account. In addition to the properties you defined for this account, Skrooge displays the following columns:

Amount
The amount available on the account, considering all operations registered, whether they are validated or not.
The amount of all validated operations. This should be equal to the amount written on your last account’s position from your bank.

The difference between the two previous columns

The total number of operations made on this account

As with all Skrooge list views, you can fully customize the table appearance.

3.3.3 Create an Account

The account creation is done using the edition panel below the accounts list.

To create an account, enter its attributes (the mandatory ones are in bold), and click on Add. Skrooge doesn’t need you to provide the initial amount of this account. In order to set the initial amount of the account, create an operation corresponding to the initial amount.

3.3.4 Modify an Account

To modify an account, select it, modify its attributes, and click on “Modify.”

3.3.5 Delete Accounts

To delete accounts, select them and either press Delete on the keyboard, use the contextual menu, or use the icon in the toolbar.

WARNING
Upon deleting an account, all operations belonging to this account will also be deleted! (But you can always undo the deletion)

3.4 Operations

Operations are, well, any operation you make on an account, be it an expense, income, transfer, sales, purchase... This is where you will probably spend most of your time when using Skrooge.

In order to enter operations, you need to have at least one account created.
3.4.1 Operation Properties

**Account**

The account the operation is made on. Select it from the list of existing accounts.

**Date**

The date when the operation was made. A calendar is accessible using the down arrow right of the field.

**Amount**

The amount is how much you spent or earned with this operation. Skrooge requires you enter this in two separate fields: Quantity, and Unit.

The quantity is negative for an expense (-30, for example), and positive for an income (+250, or simply 250). This field acts as a calculator, i.e. entering an expression such as 10 + 3.23*2 will result in the field containing 16.46.

If the sign of the quantity is not specified, then Skrooge will use the category to find the most appropriate one.

Skrooge requires you to enter the unit because an operation is not necessarily made in your main currency. For example, when you buy or purchase shares, the unit of the operation is the share unit.

**Payee**

Who did you pay this to, or who gave you the money.

**Mode**

What was the payment mode used for this operation. Something in the line of Credit Card, Cheque, Deposit... You name it!

Associated with the operation mode, is an optional number. It is mostly used to enter the check number, or a transfer number.
Category

Which Category this operation belongs to. If you need to affect more than one category to an operation, use the split mode.

You can either choose an existing category, or type a new one. In this case, Skrooge will create it for you along with the operation.

The separator between a parent category and its children is the > character. If you type Clothes > Shoes, Skrooge will create the category Clothes if it doesn’t exist yet, and its child category Shoes.

Of course, you may create entire category trees, such as Transport > Car > Fuel > Unleaded, Skrooge will happily create all the hierarchical structure.

Comment

Any comment you’d like.

Tracker

If you want to track refund for this operation, enter the name of the Tracker here. If you need to affect more than one tracker to an operation, use the split mode.

3.4.2 Operations list

The accounts list takes the form of a table with one line per account. In addition to the properties you defined for this account, Skrooge displays the following columns:

Status

This check box indicates whether this operation has been confirmed during account reconciliation. A half-greyed check box means the reconciliation is ongoing.

Bookmark

Mark this operation as Bookmarked, a synonym for Favorite.

Scheduled

When an operation is scheduled, this column shows a chronometer icon.

These columns also have some specificities:

Mode

When the operation is part of a transfer, the mode is preceded by a double arrow icon.

Category

When the operation is split, the category is preceded by a triple arrow icon.

As with all Skrooge list views, you can fully customize the table appearance.

3.4.3 Create an operation

To create a standard operation, you may use the Clear button to clear all fields and start a new operation from scratch. You can then fill its attributes (manually or using fast edition), and click on Add.

If the appropriate setting is enabled, then the category will be set automatically when the payee is set.

You may also select a similar operation from the existing operations, modify what needs to be changed, and then click on Add.
3.4.4 Split Operation

A split operation is an operation that has several dates, categories, comments or trackers. You switch to the split operation edition mode using the Split Button at the bottom of Skrooge window. When switching into the split operation edition mode, the fields Category, Comment and Tracker are replaced by a table.

To edit a cell in this table, double click on it.
You can add as many lines in this table as you need. When changing the quantity in a line, Skrooge will compute the difference with the operation global quantity, and display the remaining quantity in the last table line. If you changed the quantity in the last line, a new line will be added with the remaining quantity.

The fields here have the same behaviour as in the standard operation edition mode:

- The split by Date is useful for example when you paid your sport training for 3 months. In this case, you can split the payment on 3 months, this will have an impact on reports.
- The Category is a drop down box of existing categories. You can add a new category structure, Skrooge will create it when creating the operation.
- The Amount acts as a calculator.
- The Tracker is a drop down box of existing trackers. You can add a new tracker, Skrooge will create it when creating the operation.

3.4.5 Transfer

A transfer operation is effectively a dual operation: when creating a transfer, Skrooge will create two operations of opposite amounts (one positive, the other negative), on two different accounts. The attributes to provide here are slightly different from a standard operation:

You will find a “To Account” list where you should select the account receiving the money.
Since a transfer means “Take some money from account A and put it account B”, if you put a sign in the quantity field (+ or -), it will be ignored. The operation for account A will always be negative, positive for account B.

### 3.4.6 Shares

First of all you have to create some units with the shares you want to track, from the settings you can choose to update the data automatically when the file is opened. It is also recommended to create a different account (e.g. “ETF”) in order to keep the investments separated and be able to see them from the dashboard.

Now you can add your operations as “shares”:

- **Amount** is the number of shares you’ve bought (positive value) or sold (negative value)
- **Symbol** is the previous unit you created
- **Amount of shares** is the total price you payed for the shares / the amount you got from the selling, excluding commissions and taxes
- **Commissions** is the amount you payed your bank for that transaction
- **Tax** is any amount you payed (usually when there are earnings)

### 3.4.7 Schedule Operations

If an operation is known to be repeated on a regular basis, you may want Skrooge to automatically enter it for you in the list of operations. This can be done by scheduling an operation, using the Schedule button .

The default scheduling parameters are:

- Repeat every month
- Remind me 5 days before term
- Automatically write on term

You may change the default parameters in Skrooge settings.

You may also change each scheduled operation parameters in the Scheduled plugin.

Skrooge uses values from the last entry of the scheduled operation for writing the next one. If you increase for example the amount of your monthly contribution to the KDE effort from 100$ to 200$, next operations automatically written by Skrooge will have an amount of 200$.

### 3.4.8 Fast Edition

Whatever the chosen edition mode, there is a nifty function called Fast Edition that may speed up the work while creating new operations. It will fill the operation’s attributes based on previously entered operations. Enter a value in any field of the editor, and press F10, or click on the Fast Edition Icon (without leaving the selected field).
Skrooge will look for the first (i.e. the most recent one) operation that has the same value in the same field, and fill all other fields with values from that operation. Call Fast Edition again, it will look for the next operation, and so on.

**WARNING**
Fast Edition has no effect on the date, since it is rather unlikely that you want to create exactly the same operation, complete with the same date...
If you modified a field's value before calling Fast Edition, its content will not be affected. This is materialized by a different background color in the field, so you know it is “frozen”.

What’s different here from similar functions in other personal finances software:

- It is called on user demand
- It loops in all past operations with the same field value

And it even works on split operations!

### 3.4.9 Reconciliation

Reconciliation is the process by which you ensure that all operations in an account match the bank’s view of that account. It will involve you, your account’s position, and a pen. Reconciliation can happen only for an account at one point in time.

First, enter all the operations for the account up to that point in time; if you can, download transactions from the bank and import them into Skrooge to minimize data entry. Then, in the Operations view, select the account you wish to reconcile from the drop-down box; or in the Accounts view, double-click the account name or bring up the contextual menu and choose **Open operations**... Switch into reconciliation mode using the **Switch Information button** below the operations table.

Enter the position of your account as provided by your bank in the dedicated field. Now, you can proceed to pointing in Skrooge every operation that appears in the bank’s statement: you can either click on its checkbox in the status column or bring up the contextual menu and choose **Point**. The check box for this operation will appear part filled, until you complete reconciliation.

As you point operations, you will see Skrooge display in the information zone:

- **Delta**: the difference between the previously entered account position and the sum of all checked operations
- **Expenditure**: the total amount of Pointed debits
- **Income**: the total amount of Pointed credits

These running totals help you spot operations you may have forgotten to enter in Skrooge. Many bank statements provide similar totals such as “Withdrawals” or “Deposits and Credits”, although they may have separate totals for “Interest”, “Fees”. When the Delta is equal to 0, you may have pointed all operations matching the bank’s record. For example, you may have mistakenly pointed a debit of 8€ and a credit of 2€, and overlooked a bank debit of 6€; the net is the same, minus 6€. When the Delta is 0, the **Validate pointed operations button** is enabled. Click on this button to complete your reconciliation: all pointed operations are now checked.
**Tip**

can automatically point all imported operations for you.

If the option **Hide checked operations** for the table is selected from its “Show” menu (see *Filter the table*), then all these operations will now be hidden.

If the reconciliation is not possible for any reason, you can create a fake operation that in combination with the other operations you pointed sets the Delta to 0, thus allowing you to complete the reconciliation. To do so, click the “add” button in the reconciliation mode toolbar. You can set the default values of this fake operation in the application’s settings, in the **Operations** section. During reconciliation, if you enable the appropriate setting, Skrooge automatically points all created operations.

### 3.4.10 Template Operations

Skrooge allows you creating template operations, i.e. operations that can be reused whenever you need it. For example, imagine are used to renting a DVD to watch at home. The operation is always the same:

- **Amount**: -4.99
- **Mode**: Credit Card
- **Payee**: Acme Video
- **Category**: Leisure > Video

However, you cannot make it a recurrent operation, because you rent a DVD when you feel like it, not every week. The idea behind template operations is that it gives you a basic skeleton that can be quickly inserted in your operations list.

Since Template operations are just another kind of operations, you can access them through the operations tab, using the dedicated option in **Show** menu:

- **Operations**
- **Templates**

Creating a template is strictly equal to creating an operation, by defining its attributes. Note that you can also create a template from an existing operation (bring up the contextual menu on an operation). In this case, the template will have the same attributes as the operation.

To use a template and create a new operation from it, double click on it. A new operation will be created with the same attributes as the template, at the current date. You can then modify its attributes if needed.

Templates can also be **scheduled**.

### 3.5 Payees

The Payees view allow you to browse the payees list.
In addition to the name of payees, the table also shows:

**Address**
The address of this payee.

**Category**
The default category for this payee. This category is used automatically when the payee is set in operations page. If you don’t set it then the default category is computed with the existing operations.

**Amount**
The sum of all operations in this payee.

**Number of Operations**
The number of operations in this payee.

Double clicking on a line in this table will open the list of all operations in this payee in a new tab.

### 3.6 Categories

The Categories view allow you to browse the categories tree.
In addition to the name of categories, the table also shows:

**Amount**
- The sum of all operations in this category.

**Number of Operations**
- The number of operations in this category.

**Amount (Cumulative)**
- The sum of all operations in this category and children categories (down to the last level).

**Number of Operations (Cumulative)**
- The number of operations in this category and children categories (down to the last level).

Double clicking on a line in this table will open the list of all operations in this category in a new tab.

**WARNING**
When deleting a category, all operations attached to it will have their category deleted, hence will not have any category attached.

### 3.7 Reports

Skrooge allows you to build highly customized reports, for a deep analysis of your financial status.
A report is composed of a table (on the left) containing all data used to draw the graph (on the right). The table can be filtered using the dedicated field above, causing the graph to be redrawn with filtered data.
You can choose to display only the table, only the graph, or both.

### 3.7.1 Set up report

#### 3.7.1.1 Representation

**Table**
Display the table.

**Graph**
Display the graph.

**Text**
Display the text report, hide table and graph.

#### 3.7.1.2 Data

This is where you choose what is the data to be present in the report. Select what will be shown in lines and in columns, and the mode of computation. There are two distinct values for the mode:

**Sum of operations**
In this mode, the total amount of operations for each month will be computed. If you selected “category” in line, and “month” in column, this will compute the total amount of operations for each category and for every month.
The Skrooge Handbook

**Cumulated sum of operations**

If we reuse our previous example (“category” in line, “month” in column), we will have here a cumulated sum, i.e. for each month, we will compute the total amount of operations up to this month, for each category.

As a hand on example, this author uses this mode to draw the evolution of his accounts balance by setting “Accounts” for Lines, and “Month” for Columns.

**Base 100**

Like “Sum of operations” but on base 100.

**Cumulated sum in base 100**

Like “Cumulated sum of operations” but on base 100.

**Percent of columns**

The values are expressed in percent of the high column value.

**Absolute percent of columns**

The values are expressed in percent of the high column value in absolute.

**Percent of lines**

The values are expressed in percent of the high line value.

**Absolute percent of lines**

The values are expressed in percent of the high line value in absolute.

**Count number of operations**

For lines and columns, it is possible to expand the level of data presented using the plus icon right of the field. Use this to show subcategories in the report.

3.7.1.3 Dates

Use this to specify the date range for your report. You can use several ways to specify the date range, that should cover pretty much every possible date range you need.

3.7.1.4 Operation Types

Select the type of operations you want to include in your report. For example, if you want to draw a graph showing your expenses distribution per category, you probably do not want to include “Incomes” to your report.

3.7.1.5 Other filters

From this section, you can select some other filters defined by selection done in other pages. If you want a report only for the categories “Food” and “Gift”, you just have to open the page of categories, select the 2 categories and come back to the report to activate the corresponding filter.
3.7.2 Graph Types

Once everything is set up to your needs, you should select the graph appearance using the drop down box below the graph. To better understand the differences between each type, let us build a report showing expenses per category (lines) and month (columns):

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport</td>
<td>0.00 €</td>
<td>-3 659.42 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>-3 659.42 €</td>
</tr>
<tr>
<td>Security</td>
<td>0.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-1 680.00 €</td>
</tr>
<tr>
<td>Investment</td>
<td>-200.00 €</td>
<td>-33.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>-233.00 €</td>
</tr>
<tr>
<td>Clothes</td>
<td>-100.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>-100.00 €</td>
</tr>
<tr>
<td>Food</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>-61.45 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>0.00 €</td>
<td>-61.45 €</td>
</tr>
<tr>
<td>Sum</td>
<td>-300.00 €</td>
<td>-3 972.42 €</td>
<td>-341.45 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>-280.00 €</td>
<td>5 733.87 €</td>
</tr>
</tbody>
</table>

3.7.2.1 Stack

One bar per line, columns stacked.

The second bar (yellowish) shows category “Security”, all months stacked up.

3.7.2.2 Histogram

For each columns, every line has its own bar.
3.7.2.3 Line
3.7.2.4  Point

![Point Diagram]

3.7.2.5  Pie

The classical pie graph. If the selected value for column is different from “nothing”, displays one pie per column.

![Pie Diagrams]

3.7.2.6  Concentric Pie

This one is a bit tricky, and probably needs rework on our side. The intention is to show one ring per level of data.
3.7.3 Zoom on graph

Skrooge makes it possible to zoom in a graph for getting all the small details. Use the zoom control zone above the graph:

3.7.4 Report Examples

Here are some screenshots showing some classical report configurations. You may use them as a reference for your own reports.

3.7.4.1 Incomes and Expenses

For each month, compare the total amount of incomes versus the total amount of expenses. Incomes are in blue, expenses in yellow.
3.7.4.2 Balance Evolution

Show the evolution of the final balance on a monthly basis.

3.7.4.3 Incomes and Expenses

Display the distribution of expenses per category for the previous month.
3.7.5 Going Deeper

By double clicking on an item of a graph, you will open the operations included in this item. You can open a new report based on an item of a graph too.

So you know you can make a deep analysis of your finances thanks to reports. But how deep is deep? Well, that’s even deeper than you imagined... If you are interested, read the hands on exercise analysing this author’s expenses during its holidays :)

3.8 Monthly Report

This plugin shows an overview of your financial situation for a chosen period.
You can choose the template you want. You can even create your own template by entering the name of the template you would like to create. Your default text editor will be launched with a sample for your template. You just have to follow the comments in this sample.

Do not hesitate to distribute your templates in the category Skrooge report templates of the KDE Store.

### 3.9 Units

A unit is anything you can express an operation in. In most cases, this is a currency, but it can also be a stock, or even a car or a house. A unit has different values over time, its value being express in another unit. Example: the ACME stock is worth 31.2$ on January 2009.
3.9.1 Edit Units

Editing units can be done in different ways:

**Standard**
This mode allows you choosing amongst the set of predefined units which one you would like to add to the current document.

**Manual**
This mode allows you creating your own unit. Parameters to be provided are:
- **Name**: the comprehensive unit name.
- **Symbol**: the unit symbol, displayed in most tables and drop down boxes.
- **Type**: see Unit Types.
- **Reference Unit**: the (other) unit used to compute value of the (current) unit. For example, if you have EADS shares, and want to see their value in euros, you should select € as reference unit in EADS unit.
- **Country**
- **Download source**: The source to download quotes. The recommended one is “Yahoo”. By clicking on the arrow on the right of the “Download” field, you can directly download new sources from store.kde.org
- **Internet Code**: The Internet code for this unit. If given this code, Skrooge is able to download the unit values from selected source.

**Values**
This edition mode allows to download unit values from Internet, or to manually enter a unit value at a given date.
3.9.2 Unit Types

Even if Skrooge considers just about anything as a unit, it makes a distinction depending on their type:

**Primary Currency**
- This is the currency that will be used for displaying real operations amount.

**Secondary Currency**
- If defined, the value in the secondary unit will be displayed upon hovering over an operation amount.

**Currency**
- Any currency, with no specific role for display.

**Share**
- This type of unit can be used for managing shares.

**Index**
- A stock exchange index, such as the Dow Jones, Nasdaq, CAC40, SBF120...

**Other**
- Any unit that doesn’t fit in the above types.
Chapter 4

Using Skrooge (advanced)

4.1 Scheduled

This plugin shows you the list of all scheduled operations.

This is where you can set up each scheduled operation to have its own parameters.

Next Occurrence
Displayed for information, but can also be used to force the date of the next occurrence.

Once every
You can set an operation to be repeated over a given number of days, months, or years.

Number of Occurrences
If the occurrence has a limited number of occurrences, you can check this option and define either the number of remaining occurrences, or the date of the last occurrence.
Remind me
If you want Skrooge to display a notification to remind you about the upcoming scheduled operation, you may check this option and set the number of days before term when the warning shall occur.

Automatically Write
If you want Skrooge to automatically write the upcoming scheduled operation, you may check this option and set the number of days before term when it will be written.

To modify the operation (category, amount, ...), you have to click on Jump to the operation.
Double clicking on a scheduled operation will display the list of operations already registered for this scheduled operation in a new tab.

4.1.1 Scheduled Operations
If you schedule an operation, it will be used as a reference when inserting the next occurrence. Let us see an example, with this operation:

<table>
<thead>
<tr>
<th>Date</th>
<th>Payee</th>
<th>Category</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20/06/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
</tbody>
</table>

Table 4.1: Scheduled Operations (step 1)

Now, if you schedule this operation, it will be written exactly like this for the next occurrence:

<table>
<thead>
<tr>
<th>Date</th>
<th>Payee</th>
<th>Category</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20/06/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
<tr>
<td>20/07/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
</tbody>
</table>

Table 4.2: Scheduled Operations (step 2)

If you change something in the last occurrence, it will become the new reference for the next occurrence. For example, if you raise your monthly contribution to KDE to 25€ in July, the next occurrence will also be with an amount of 25€:

<table>
<thead>
<tr>
<th>Date</th>
<th>Payee</th>
<th>Category</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20/06/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
<tr>
<td>20/07/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>25€</td>
</tr>
<tr>
<td>20/08/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>25€</td>
</tr>
</tbody>
</table>

Table 4.3: Scheduled Operations (step 3)
All in all, a scheduled operation is a dynamic object, where the last occurrence is the reference. But maybe you’d like all occurrences to be static, i.e. the same values are always inserted for each new occurrence? Enter Scheduled Templates.

### 4.1.2 Scheduled Templates

Templates are some sort of reference operations. When scheduling a template, every new occurrence will be exactly equal to the template. Let’s reuse our previous chapter example, by creating a template like this:

<table>
<thead>
<tr>
<th>Date</th>
<th>Payee</th>
<th>Category</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20/06/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
</tbody>
</table>

Table 4.4: Scheduled Templates (step 1)

The next occurrence will be:

<table>
<thead>
<tr>
<th>Date</th>
<th>Payee</th>
<th>Category</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20/06/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
<tr>
<td>20/07/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
</tbody>
</table>

Table 4.5: Scheduled Templates (step 2)

Now change your July contribution to KDE to 25€. Because you have scheduled a template with 20€ as amount, the next occurrence will also have an amount of 20€:

<table>
<thead>
<tr>
<th>Date</th>
<th>Payee</th>
<th>Category</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20/06/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
<tr>
<td>20/07/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>25€</td>
</tr>
<tr>
<td>20/08/2009</td>
<td>KDE</td>
<td>Donations &gt; Open Source</td>
<td>20€</td>
</tr>
</tbody>
</table>

Table 4.6: Scheduled Templates (step 3)

If you need to change the monthly value, just edit the template, and all future occurrences will have the new value.
4.2 Trackers

The trackers allow you to aggregate some operations together in a group, so you can follow them more closely. This may come handy to follow expenses for which you expect a refund, or simply knowing how much you spent during your last holidays in the Bahamas.

For example, imagine you have been sent to Italy by your company. Once there, you paid your hotel room: in Skrooge, you can create an operation in category “Business > Travels > Hotel”, and assign a tracker called “Business Travel in Italy”. You can assign this tracker to all professional expenses you make there. Then, if all goes well, your company pays you back for all these things, and you can create an income operation, and also affect it to the “Business Travel in Italy” tracker.

By affecting trackers to operations that shall be reimbursed, you are able to follow completion of the reimbursement.

This, of course, works also the other way round: if someone lends you some money, you are able to monitor how much you still have to reimburse.

Double clicking on a tracker in the track view will open a new tab containing all operations attached to this tracker.

Tip

Sometimes, you would like to track the refund of a payment done before you started to use Skrooge. How to do that because it is not possible to set an initial amount on a tracker?

You can create a split operation with:

- `amount=0` to avoid impact on reports.
- a split with the expected amount associated to the tracker.
- the other split with the opposite amount not associated to a tracker.

4.2.1 Close Tracker

When you no longer need the tracker, for example because it has been fully reimbursed, you may simply delete it. Doing, this, however, will lose all information you have entered, and that may
be of interest for future reference.
A cleaner solution is to close the tracker: when a tracker is closed, it can be easily hidden from
the trackers view, using the dedicated option.

4.3 Search & Process

This plugin allows you building complex queries to find operations, and optionally apply them
some transformations. Here is a use case:

John downloads some data from his bank. The data comes, obviously, without indica-
tion on the category. In fact everything is written in the comment field. John would
like some automatic way to correctly set up the category and other attributes based
on the content of the comment.

So how does this work ? First, you will define a search criteria, that will give you a list of opera-
tions. Then, define the transformations to apply on these operations.

NOTE
A real case study can be found in appendix, providing some hands on exercise for the hereabove use

case.

4.3.1 Define search criteria

Here, you can define the query for finding operations, using a combination of parameters. On
the above picture, you can find a table with operation attributes for header. By editing a line, you
create a new clause in the query. Each column is combined with other columns using a logical
“and”: (column1 and column2)
If you add a new line, you create another clause combine with the first line by a logical “or”: [line1] or [line2].
All in all, the combination of columns and lines can be read as:
(column1 and column3) or (column2 and column3)
Of course, you can have as many lines and columns as you need in a search query.
Once satisfied with a query definition, you can add it to the list of existing search criteria, or
modify an existing one.
4.3.2 View search results

When selecting a search query in the queries view, the number of found operations is displayed below the table:

When double-clicking on a search query in the query view, all found operations are displayed in a new tab:

4.3.3 Define Processing

If you need to apply some processing on all operations found, select the concerned query, and activate the process definition panel:

In this panel, you can define the transformations to perform on operations. Note that it is intentionally impossible to set an operation’s amount or date in this panel.
4.3.4 Define Alarm

A special kind of use of the Search & Process plugin is the ability to define alarms. An alarm is basically Skrooge calling your attention on some kind of event, such as your monthly budget for a category has been reached.

To define an alarm, define first the search criteria giving the set of operations on which you need alert. For example, all operations in current month and in category “Clothes”. Then, define the amount for which the alert shall be raised, for example 100€, and define the Alarm message that Skrooge will send you when the amount is reached.

**Tip**

Alarm messages can have parameters for the total amount (%1), alarm amount (%2) and difference (%3).

4.4 Budgets

This plugin allows you to define and manage your budget.
Like in all other financial software, Skrooge allows you to define a budget. You can do it manually or automatically.

### 4.4.1 Budget definition

In manual mode, you can:

- Define a budget amount for a category for a year.
- Define a budget amount for a category for all months of a year.
- Define a budget amount for a category for a specific month of a year.
- Define if income or expenditure of sub categories must be taken into account in the defined budget (example: if the option is selected then a budget for the category "Car" will take into account the category "Car > Fuel").

**Tip**

You can define a budget capturing all income or expenditure not defined in another budget by leaving the category empty. This is really useful to be sure that you do not miss an expenditure.

In automatic mode, you can:

- Define a budget for a year based on the operations of the previous year.
- Define missing budget items to balance each month and/or the year. Even on manually defined budget.
4.4.2 Budget rules

To go further in budgeting we will take as example the following balanced budget:

- -500 € / month for “Food”.
- +500 € / month for all other categories of expenditure and income.

Imagine now, that you spent 600 € for “Food” during the previous month! Skrooge informed you that you are over the defined budget but you cannot stop to eat. So you spent more than expected! How to do with that?

Budget rules will allow you to define how you want to do with the delta (positive or negative). For example, you can choose to transfer the delta of one month to the next month. In this case, your new budget for “Food” for the current month is -400 € (-500+100). So you have to take care to recover the situation.

Budget rules can also help you for your project. For example, you can define a rule like this: All positive delta (saving) on “Food” are transferred in “Holidays”. By this way, when you have the expected amount in “Holidays” budget then you know that you can go.

4.5 Simulations

This plugin allows you to do simulations.

You can define the rates for each account and estimate the annual interest. You can also generate an amortization table.
Chapter 5

Settings

You can find here a description of all settings used by Skrooge. These settings are common with all your documents.

5.1 General

You can set here the main general settings. The most important ones are those to describe what to do when a page or a bookmark is modified.
5.2 File

All these settings are relative to the storage. You can choose how to create backup files, if you want to use the KDE wallet to store passwords...

5.3 Bookmarks

Only one option here to choose whether or not we want to pin automatically loaded bookmarks.
5.4 History

These options will help you to better manage your modifications history.

5.5 Dashboard

Only one option here to choose the dashboard you want (QML or not).
5.6 Operations

Here you will find options for editing operations.

Please note that you can improve performances if you don’t use the “balance” column by avoiding calculating balances for nothing.

What to do, if an action breaks a reconciliation: A check is made after each modification to see if the modification breaks the previous reconciliation. Here you can choose what to do if this happens.

What to do, if an action breaks an import: A check is made after each modification to see if the modification breaks the previous import. Here you can choose what to do if this happens.
5.7 Scheduled operations

Here you will find options for editing scheduled operations.

5.8 Search and process

Only one option here to choose the alarm frequency.
5.9 Report

You can choose some display options for reports here.

5.10 Units

You can choose some options relative to download of unit quotes here.
5.11 Import / Export

The general import settings.

If you use the CSV import, you will have to modify these settings to help Skrooge to identify the columns.
In some specific case, you could have to force the date format for QIF files. Most of the time, Skrooge is able to find it automatically.

You can activate the import backends from the list here.
Chapter 6

How to...

1. How to use Skrooge in my language?
Check if Skrooge is well translated to your language and if you have installed all packages for Skrooge provided by your distribution.

2. How to set default currency and date format?
Default currency and date format are retrieved from Plasma’s System Settings. Some distributions do not ship it with Skrooge. In such case you should install it through your distribution’s package manager.
You can then start it in a console: `systemsettings5`
And select your preferred settings, in the **Format** section.

3. How to reduce the size of my document?
The size of your document can be very important. If you delete some old transactions, the size will increase. This is normal because Skrooge keeps the history of all modifications for the undo/redo mechanism. So if you want to reduce the size of your document, you just have to clear the history.

4. How to define a new invoice extractor?
Skrooge uses `pdftotext` to extract all strings of a PDF. After that, it uses a text file describing how to find key values. If you want to define a new invoice extractor, you have to do that:

- Launch `pdftotext` on your PDF file
- Open the text file generated and the corresponding PDF file
- Create a new text with an extension `.extractor`. Example: `google.extractor`
- Your file must be like this:

  ```
  payee=REGEXPCAP:^\(Biofan\) SPRL$
date=REGEXPCAP:^Order Date: (.*)$
dateformat=dd MMM yyyy
number=REGEXPCAP:^N° de facture (.*)$
mode=SET:Carte
comment=REGEXPCAP:^N° de commande (.*)$|SET:Commande %1
amount=REGEXP:^Montant global:|LINEOFFSET:2
  ```

Each attribute (payee, date, number, mode, comment and amount) use the same syntax: `COMMAND:value | COMMAND:value | ...

The command can be:
- **REGEXPCAP**: This is a regular expression capturing a value
- **REGEXP**: To find the line in the file matching a regular expression
- **LINEOFFSET**: To change the line index.
- **SET**: To force the value. Can be used as first command or after the REGEXPCAP (see example).

dateformat is the format of the date extracted.

- Put this file into the same folder as all other `.extractor` files
Chapter 7

Credits and License

Skrooge
Program copyright 2008-2020 Stéphane Mankowski stephane@mankowski.fr
Documentation copyright 2008-2020 Guillaume DE BURE gdebure@yahoo.com
This documentation is licensed under the terms of the GNU Free Documentation License.
This program is licensed under the terms of the GNU General Public License.
Appendix A

Search & Process real case study

OK, we have to admit that while being quite powerful, the Search & Process plugin is maybe a bit tricky to understand. Here is a small exercise that will give you a hold od it. Remember the use case for Search & Process?

John downloads some data from his bank. The data comes, obviously, without indication on the category. In fact everything is written in the comment field. John would like some automatic way to correctly set up the category and other attributes based on the content of the comment.

John knows that his bank put the name of the payee in the comment field. And he wants all his payments to KDE to be in category Donations & Open Source. We will look for all operations with the comment field containing KDE:

<table>
<thead>
<tr>
<th>Comment contains ‘KDE’</th>
</tr>
</thead>
</table>

Table A.1: Search Definition

Add this search definition to the list of existing searches using the Add button.

Next we need to tell Skrooge to set all operations found by this query in category Donations > Open Source. Change the Query type to Update using the drop down box, and define the transformations to apply:

<table>
<thead>
<tr>
<th>Comment</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>=&quot;&quot;</td>
<td>=’Donations &gt; Open Source’</td>
</tr>
</tbody>
</table>

Table A.2: Update Definition

Notice that we also removed the original comment by setting it to an empty string. This is for readability sake, but you may wish to keep it for historical reasons.
Add this process to the previously defined search using the Add button.

So far, so good. Now, let’s apply the process on all imported operations not yet validated (click on the Apply button):

That’s it! If you go back to the operations view, you will notice that all concerned operations have been updated. In case anything went wrong, do not forget that Undo is your friend! Even if the process modified 2327 operations, this is still one undoable action for Skrooge.
Appendix B

Deep analysis exercise: Holidays expenses

To illustrate the analysis capabilities of Skrooge, we are going to examine this author’s expenses during his holidays :).

B.1 Analysis Context

In order to understand the exercise, you need to know a few things about these holidays. They span over nearly a full month during summer 2009, and involved renting several rooms in several locations in France. There was also a fair amount of fuel, as these holidays also spanned over a rather large part of France.

B.2 Data Organisation

The author carefully entered his operations, by affecting them categories, but also by adding them to the “Holidays, summer 2009” tracker. Categories often have subcategories, such as “Transport > Car > Fuel”, allowing for this detailed analysis.
B.3 Finding the holidays total cost

This is so easy, it is not even funny: open the Trackers view, read the “Amount” column for our tracker:

Let’s move to more interesting stuff...
B.4 Expenses Distribution

So this is all very good, but where did all that money go? To find this out, let us build a report on the tracker. Right click on our tracker line and choose Open report....

This will open a report in a new tab, only for operations associated with the tracker. The default parameters for dates are “Current Month”, so there is a possibility that the report is empty if all operations in the tracker were made before this. Let’s change it to “All Dates”:

This gives a first nice overview of the expenses per category. Let’s display this in a pie chart, for a more natural presentation:
It is now quite clear that most of the holidays expenses were for transport and food. Any more indication? Sure, let’s dig one level more in categories, using the plus icon.

Hmm, not much more information here, except that in the “Transport” category, the “Car” subcategory is the only one used. Let’s build a graph on that subcategory, by selecting the pie slice, right-clicking on it, and select Open report:
This will open another tab with a report only with the “Transport > Car” category.

Hmm, not really interesting... But there is more subcategories. Let’s expand it again:
Ah, now we know that we spent 362.27€ on fuel, and 131.90€ on road taxes (in France, you have to pay to drive on some highways). Ok, I know this was to be expected ;-). I am also interested in knowing how these two categories were used over time:

Note that we changed the graph type to “Line”, and the columns to “Week”.

B.5 Conclusion

Through this simple exercise, we have been able to use the advanced reporting capabilities of Skrooge to perform a fine analysis of the expenses made during holidays, specifically in the “Transports” category. Of course, you may think of other use cases: Skrooge is probably able to cope with them.